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Introduction

Qu’est-ce que Visual Micro ?
Visual Micro est une extension pour Microsoft Visual Studio 2008-2019 permettant de développer, compiler et transférer un projet dans une

carte Arduino tout en tirant partie de la puissance de I'IDE Visual Studio. Visual Micro est totalement compatible avec I'environnement de
développement Arduino et utilise les mémes bibliotheques, code source et outils de développement.

Visual Micro et Arduino ?

Sans Visual Micro Avec Visual Micro

Pour commencer

Installer Visual Micro pour Arduino dans Visual Studio

1. Installer le logiciel Arduino
2. Installer Visual Studio 2019 (en 2019)
3. Installer Visual Micro

Configurations

Ouvrir I'outil de configuration : VMICRO -> Ide -> Configuration Manager
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E Précise le type et la version de I'IDE Arduino installé sur le PC.
aSpécifie le répertoire d’installation de cet IDE.
ETéIéchargement et installation de I'IDE Arduino (si non installé).

e ——
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Créer un nouveau projet dans Visual Micro, le compiler, le télécharger et I’exécuter

Nouveau projet

Creste 2 new arduino sketch project? X
e  Dans Visual Studio, cliquer sur: File>New > Arduino Project Brter o s Fortha s Avchiao btk
. Entrer un nom pour le projet et cliquer sur OK e
v

ICette action crée un répertoire dans ../Document/Arduino.|

Un projet vide est créé comme sur la copie d’écran ci-dessous :

Soution xlore Wyistrroectinn = x IR

@l o-2ddosR|R _(Global Scope) 1

= l'o id setup()

o

] Solution ‘MyFirstProject’ (1 project)
4 % MyFirstProject /* add setup code here */
b &3 External Dependencies
b &5 Header Files
&:' Resource Files Svoid 1oop()
= Source Files {
b+ MyFirstProject.ino

3
J

* add wmain program code here *

Une fonction setup() et une fonction loop() ont été automatiquement créées. Vous pouvez les compléter avec votre code.

Sélectionner le modeéle de la carte et la liaison série

Avant de télécharger le code, vous devez sélectionner le modéle de la carte et la liaison série. Ceci est expliqué dans le paragraphe ci-dessous.
Si la barre d’outils Visual Micro n’est pas présente dans le bandeau, faire un clic droit et sélectionner " " dans le menu contextuel.

Modéle de la carte Arduino
Utiliser la barre d’outils Visual Micro présentée sur la copie d’écran ci-dessous.

m newBlink - Microsoft Visual Studio
FILE EDIT  WIEW  PROJECT  BUILD

‘e -o|n-aMd|9-

- |Arduino 1.6 '| |Arduir‘|u:u Marni '|

¥ Sila barre d’outils Visual Micro n’apparait pas, faire un clic droit sur le bandeau et cocher "Micro Boards".

e  Sivous avez installé plusieurs versions du logiciel Arduino dans le "Configuration Manager", sélectionner la version que vous voulez

utiliser [Arduine16 |
. Dans la liste des cartes , choisissez celle que vous voulez utiliser.
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Quelques cartes nécessitent un paramétrage supplémentaire, vous devez le réaliser pour qu’elles fonctionnent correctement
Si votre carte dispose de telles options, une autre barre d’outils apparaitra afin que vous puissiez les sélectionner.

1 SQL TOOLS TEST ANMNALYZE WINDOW  HELP

dows Debugger -

|

" | Serial ~| 116 MHz

~| USEnglish |

* I X Digitalino & >
(Global Scope)

En survolant les différents champs avec la souris, vous obtiendrez des informations sur leur réle.

Vous pouvez aussi utiliser Tools > Visual Micro > Options pour sélectionner les options de votre carte.
Port série

. Relier la carte Arduino au PC avec un cable USB.

Vous pouvez maintenant sélectionner le port série. Utiliser la barre d’outils "Visual Micro Serial Communications".

n Boards.txt Editor - Microsoft Visual Studic
FILE EDIT VIEW  VASSISTX PROJECT BUILD DEBUG TEAM

S | Vo - @l W g ’ - = | P Local Windows Debugger
* | Arduino 1.6 '_’ ’Arduino Nan " % - {coms

']'r @ -

>

¥ Si la barre d’outils Visual "Micro Serial Communications" n’apparait pas, faire un clic droit sur le bandeau et cocher "Arduino Serial
Communications"

Sélectionnez le port série dans la liste déroulante. Normalement, vous devriez seulement voir le port série auquel la carte Arduino
est connectée.

== Sj vous changez de port USB, le numéro change. En cas de probléme lors du téléchargement du sketch, vérifiez d’abord le port
série utilisé. (Périphériques et imprimantes)

Ajouter des outils provenant d’autres fabricants

Visual Micro peut recevoir des chaines de compilation de fabricants autres qu’Arduino, tels que Intel, Adafruit, Teensy etc.
Cette page (http://bit.ly/2Hy3BSV) explique comment les installer en utilisant "Visual Micro's Board Manager".

¥ Assurez-vous d’avoir sélectionné la bonne carte et le bon port série.

e —
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Compiler et télécharger

®

e  Compiler et télécharger le sketch en appuyant sur la touche ou en sélectionnant Debug > Start Debugging dans le menu.

Si la compilation réussit, Visual Micro effectue le téléchargement dans la carte Arduino. Une fois le sketch téléchargé, le programme
s’exécute.

Les étapes de la compilation sont affichées dans la fenétre de sortie Output Window (http://bit.ly/2VIeKo9) . Si elle n’est pas présente,

vous pouvez |'afficher avec View > Output ou en appuyant sur la combinaison de touches [Ctrl+Alt+0]

Output

Show output from: | Micro Build '|| 2 | | | =g

Compiling 'Blink' for 'Arduino Nano w/ ATmega32s’

Binary sketch size: 3.868 bytes (used 18% of a 38.72@ byte maximum) (8,61 secs)
Compiling debug version of 'Blink' for 'Arduino Nano w/ ATmega323'

Binary sketch size: 3.838 bytes (used 12% of a 3©.72@ byte maximum) (1,36 secs)
Uploading to I/0 board using 'COM3®

Done uploading

¥ Pour utiliser les possibilités de débogage de Visual Micro, assurez-vous d’avoir sélectionné le mode Debug, comme ci-dessous :
N IWICrosoTt visual studio
FILE EDIT VIEW  VASSISTX PROJECT BUILD DEBUG  TEAM
o - | Vo -~ W M | - - | P Local Windows Debugger
ElArduino 1.6 '| |Arduino MNan "l 7 = ’W‘ Ql =

Si vous ne souhaitez pas utiliser le débogueur ou si votre sketch est dans sa version définitive ("Release"), choisissez "Release". Pour
en savoir plus, consultez la page du site accessible ici (http://bit.ly/2VIfOU9).

Pour compiler le sketch sans le télécharger, appuyez sur [Ctrl+Maj+B] ou sélectionnez Build > Build Solution.

¥ Sivous avez plusieurs projets dans votre solution, consultez cette page ( http://bit.ly/2QmPSB7 ).

Arréter I’exécution du programme

(Disponible seulement avec la version payante)
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Ouvrir un sketch Arduino dans Visual micro

Si vous avez des projets créés avec I'IDE Arduino, vous pouvez les transformer en projets Visual Studio et continuer a travailler dans Visual

Studio.
Pour cela :

e  Cliquer sur File > Open > Arduino Project (avec |'extension .INO ou .PDE),

ou

e  Cliquer sur File > Open > File dans le répertoire d’un projet Arduino.

e  Sélectionner un fichier .INO ou .PDE
Visual Micro vous demandera si vous voulez créer un nouveau projet. Si vous répondez "Oui", Visual Micro créera un projet Visual

Studio a partir des fichiers .INO, .PDE et .CPP dans ce dossier.

]
&= Comme avec I'IDE Arduino, Visual Micro nécessite de nommer de la méme fagon le fichier .ino principal et le répertoire le contenant.

Le fichier .ino principal est celui qui contient les fonctions setup () et loop().

Votre écran ressemblera a la copie ci-dessous :

Solution Explorer Blinkino + X
@B e-2dm|losrR P T Sy
o =1/

i i bl il P Blink

LED on for one second, then off for

] Solution ‘MyFirstProject’ (1 project) urns on an
4 [%] Blink
b & External Dependencies
> B Header Files
b Resource Files Svoid setup() {
b Source Files + / init
b % AnotherFileino
b+ Blinkino

s example code is in the public dosain.

islize th

Pin 13 has an
pinMode(2, OUTPUT);
Serial.begin( 11520@ );

}

void loop() {

- digitalwrite(2, HIGH); set the LED o
Serial.println( “Hallo..." );
delay(1000};

Vous pouvez maintenant éditer votre code.

¥ Sivous décidez d’utiliser a nouveau votre fichier avec I'IDE Arduino, pas de probléme : Visual Micro et Arduino sont rétro compatible.
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Ajouter et effacer des fichiers

Lorsque votre projet prend de I'ampleur, il est préférable de le diviser en fichiers sources indépendants pour maintenir une structure claire.
Avoir des fichiers sources séparés réduit également le temps de compilation, surtout si vous décidez d'utiliser des fichiers .CPP lieu de fichiers
.INO.

Le programme résultant sera identique. C'est juste une question d'organisation des sources !

Ajouter un nouveau fichier

Dans la barre de menu, cliquer sur VMICRO -> Add Code

tSe Arduno L6 >

Board  Arduno Neno w/ ATmegeilll «

P Vausl Micrk

(erery .

Ad Empry Arduino e @)

& y Arduno Cpp and Heades @) |
234 gy Ardumo .C 200 Hesder o

A3 New Moding Class and Meader o

A New Acshain Libeary o

ASd Boed tt 0

Apreés avoir cliqué sur |'option de menu, un nouveau fichier .INO, .C, ou .CPP est ajouté a votre projet. Vous serez invité a entrer un nom de
fichier. Entrez le nom du fichier sans I'extension. Les trois types de fichiers sont utilisés pour écrire du code source.

B Add Empty .ino Ajoute un nouveau fichier vide .ino au projet.

E Add Empty Arduino .cpp Ajoute un nouveau fichier .cpp vide et son fichier d’en téte .h associé.
and Header

B Add Empty Arduino .c Ajoute un nouveau fichier .c vide et son fichier d’en téte .h associé.
and Header

n Add new Arduino Class Ajoute un fichier .cpp et un fichier .h contenant un modele de classe c++.
and Header

E Add New Arduino Library Ajoute une nouvelle bibliotheque Arduino.

E Add board.txt Ajoute un fichier texte board.txt.

Les types de fichiers

. Les fichiers .ino sont a la norme Arduino. Lors de la compilation, Visual Micro traite tous les fichiers .ino comme s’il s’agissait d’un seul

fichier. Voila pourquoi vous n’avez pas a gérer de fichiers .h aussi longtemps que vous utilisiez seulement des fichiers .ino.
. Les fichiers avec I'extension .c sont utilisés pour écrire du code en langage C.
. Les fichiers avec I'extension .cpp sont utilisés pour écrire du code C++. C'est le méme langage que pour les fichiers .ino.

Avec le fichier .cpp, Visual Studio crée également un fichier avec I'extension .h. Le fichier .CPP nouvellement créé contient un modele de
classe. Si ce code ne correspond pas a vos besoins, supprimez-le simplement.
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Quels types de fichiers utiliser ?

Pour en savoir plus sur les types de fichiers : lien ( http://bit.ly/2WncruX ).

Ajouter un fichier existant

Projet -> Add Existing Item

Effacer des fichiers

Si vous voulez supprimer un fichier de votre projet, cliquez dessus dans I'explorateur de solution et appuyez sur [Del]. Une boite de dialogue
apparaitra vous permettant de choisir entre "Enlever" et "Supprimer".

¥ Enlever signifie seulement que le fichier n’apparaitra plus dans I'Explorateur de solutions tout en faisant toujours partie de votre solution.

ils Supprimer un fichier le retirera du projet et I'effacera sur le disque.
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Travailler avec des fichiers, projets et solutions
Ajouter une bibliothéque dans votre sketch
Qu’est-ce qu’une bibliotheque ?

Les bibliothéques sont des modules, codés par d’autres personnes, que vous pouvez intégrer dans vos projets.
L’'IDE Arduino de base s’ouvre avec un grand nombre de bibliothéques permettant de contréler un moteur pas a pas, lire ou écrire dans une
EEPROM etc. Vous trouverez une description des bibliothéques Arduino sur Arduino homepage [ http://bit.ly/2Evpu3l ].

Pour ajouter des bibliotheques

vMicro
Ide Arduino 1.6 *
Boord Arduino Nanc w/ ATmegad28 ~
£ Vaual Micro Bxplores

General »

Progect Properties

Add Litirery —_— Buit-in select » built-in ide oc hardware library =

Add Code ’ User select a user inctalled ltbrarcy »
:I Build D Install Arduino Library
(3 Build & Upload Refresh

e Built-in permet d’ajouter une bibliotheque provenant de I'IDE Arduino ou du fabricant de la carte Arduino
e  User permet d’ajouter ses propres bibliotheques
e Install Arduino Library (voir ci-dessous)

o  Refresh : Met a jour la liste des bibliotheques installées pour qu’elles apparaissent dans les listes de sélection Buit-in et User

, T \ . . . . . L This example code is in the public doma
Lorsqu’une bibliotheque est ajoutée, Visual Micro place la directive include dans le code. y

#include <LiquidCrystal.h> <ff——
—lwvoid setup() {
= // initialize the digital pin as an out

¥ Note : Dans le sous-menu"Core", Visual Micro ne montre que les bibliothéques compatibles avec la carte sélectionnée. Si vous changez de
cible, vous constaterez que la liste change aussi.

Mise en oeuvre - Visual Micro pour Arduino.docx [24052019] Page 10



http://arduino.cc/en/Reference/Libraries
http://bit.ly/2Evpu3l

Visual Micro for Arduino | 2019

Chemin des "bibliothéeques utilisateur"

Visual Micro recherche les bibliotheques "utilisateur" dans le sous-répertoire "Libraries" du répertoire des sketchs (sketchbook folder) spécifié
dans le "Configuration Manager” [http://bit.ly/2VXTzn6]. Si vous n’avez rien précisé, Visual Micro les recherche dans le sous-répertoire

"Libraries" par défaut : /Documents/Arduino/Librairies.

; Libraries " 0
|

My new sketch
 MyRobot .
, Metduine e

J Plant Humidity Controller
—

est le répertoire des bibliothéques utilisateur, E sont les répertoires de vos sketchs.
Vous devez créer un sous-répertoire dans le répertoire "Libraries" pour chaque bibliothéque :

4 | Libraries
J Fastl2C
; MonochromeLlCD
J SerialEEPROM

Installer des bibliothéques supplémentaires directement a partir du web

Bl Install Arduino Library

Vous pouvez installer de nouvelles bibliotheques téléchargées sur le web avec le menu .
Faire un clic sur le fichier .zip contenant la bibliothéque, Visual Micro I'installera dans le répertoire utilisateur des bibliothéques.

L]
L22 N’oubliez pas de mettre a jour la liste des bibliotheques installées avec Refresh pour qu’elles apparaissent dans les listes de sélection
User.

La barre d’outils « Micro Project »

Vous pouvez accéder a la fonction d’ajout des bibliothéques avec la barre d’outils représenté ci-dessous
€ | Add Library = Add Code~ | (21 (B (=) -

Pour I'afficher, faire un clic droit dans le bandeau et cocher "Micro Project".
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Le Gestionnaire de bibliothéque (Librairies Manager)

L

Le gestionnaire de bibliotheque est une partie de Visual Micro Explorer. Vous pouvez I'afficher en cliquant sur le symbole dans la barre

d’outils, ou a partir de VMICRO > Visual Micro Explorer dans le menu.

Pour ouvrir le gestionnaire de bibliothéques, cliquez sur 'onglet | 'enags Lbrares .

Visual Micro Explnrr:rm m il = ¢
¥ Ide Arduino 1.6 - Configure | Rescan

Installed | Reference | Examples | Manage Boards | Manage Libraries | Search www | News
Search Refresh
- Library Installer
- Al (227)
[~ Installed (24)
[#- Available Updates (7)
[+~ Arduino (12)
[ Authors (61)
[+ Maintainers (38)
[#-Categories (11)

227 libraries found for Ide wersion 1.6.4

Install a ibrary from a zip
View the user libraries folder
View the current ide folder

Ready
Le gestionnaire de bibliotheque vous permet d'installer et de désinstaller des bibliothéques Arduino et d'autres fabricants.

Différence entre "Installer" et "Ajouter" une bibliotheque

Installer une bibliothéque signifie la télécharger et la sauvegarder sur votre PC, aprés quoi elle est préte a I'emploi. L’installation d’une
bibliothéque ne l'intégre pas a votre projet. Elle n’occupe pas de mémoire dans le microcontréleur. Elle est uniquement présente sur le PC et

non utilisée jusqu'a ce que vous l'ajoutiez a votre projet.

Ajouter une bibliothéque a votre projet lui permet de devenir une partie intégrante du projet ; Elle peut étre utilisée. Apres l'ajout de la
bibliothéque, son code sera téléchargé sur la carte avec le votre.

Bien sr, vous pouvez seulement ajouter les bibliotheques qui sont installées !
Installation et désinstallation d’une bibliotheque
La structure de I'arbre g} ci-dessus permet de sélectionner les bibliothéques a installer ou a désinstaller en fonction de criteres.

Les bibliothéques installées apparaissent en gris, les bibliothéques qui ne sont pas installées sont affichées en noir. En cliquant sur un lien, vous
pouvez installer / désinstaller la bibliothéque correspondante.

"All" Affiche toutes les bibliotheques disponibles, installées ou non, dans l'ordre alphabétique.

"installed"” Affiche uniquement les bibliotheques installées. Cliquez sur un élément pour le désinstaller, une fenétre de
nstalle
confirmation apparaitra au préalable.

I i Affiche toutes les bibliothéques installées pour lesquelles une mise a jour est disponible. En cliquant sur un
Available Updates o . L
élément, la mise a jour va s’exécuter.

Affiche toutes les bibliothéques fournies par Arduino. La plupart d'entre elles sont préinstallées lors de

"Arduino" . .
Iinstallation de I'IDE.
"Authors" Affiche les bibliotheques regroupées par auteur.
"Maintainers" Affiche les bibliothéques regroupées par responsable (les personnes qui maintiennent la bibliothéque apres
que l'auteur ait écrit la version initiale)
N o Affiche les bibliotheques regroupées par domaine d'application.
Categories

Ce noeud est particulierement utile si vous étes a la recherche d'une solution a un probléme.
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Obtenir des informations sur une bibliothéque (version payante du logiciel)

Le nom d'une bibliotheque dans |'arborescence n’est pas d’une grande aide pour décider si on doit I'installer ou non. Si vous passez la souris

sur le nom de la bibliothéque (sans cliquer !), la partie inférieure de la fenétre est mise a jour et affiche des informations supplémentaires.

Vous pouvez ensuite déplacer votre souris sur le lien "Plus d'infos" et cliquez dessus. Il vous dirigera vers une page d'informations dans votre
AN

navigateur web. Si le mot "installé" apparait en vert, alors vous avez la version la plus récente. Si le mot "installé" apparait en rouge, une
nouvelle mise a jour est disponible. Vous trouverez cette mise a jour sous la rubrique "Mises a jour disponibles" dans I'arborescence.

v He Arduncls * Ceafigure  Rescen
katalad | Refermnce | Bxamples | Marage Boasls | Mensge Lbrates | S ¢ 1 ¢
3 Adana 3 -

i+ Angas Gratton (&)
- Ardano {12

Signal IngutOutput
o by Ardung (' 5.0 demmicadabie Mt i

Alloves playing woctio hiss from an 50 cerd tor

Arduing DUE only, 'A50h 29480 IReary »ou Gan uis 1he Avduing Due DAC outpus 10
play sodo Sles

Tre 2ucio frma munt Se 0 S rea e fomat

Renommer des fichiers et des projets
En fonction du résultat attendu, il existe plusieurs méthodes pour renommer des fichiers et des projets.
Dans tous les cas, vous devrez ouvrir la fenétre de I'Explorateur de solutions. Si elle n’est pas ouverte, appuyez sur [Ctrl + Alt + L].

@lo-2GFW o rmB R

01 Selution Dink (1 peoject)

4 P Bink f— X/
P 53 Extrenel Depenclenciey A
b E Hedder(les

Fesource Riles

¥ S Source File

b *+ Sinkino 4— J/

L e fichier .ino principal, le dossier le contenant sur le disque dur et le projet doivent toujours avoir des noms identiques.

Ne pas renommer le projet («X» rouge ci-dessus), renommer le fichier.ino a la place, comme indiqué ci-dessous. Cela

renommera le projet et le dossier.

Pour en savoir plus [http://bit.ly/2WnijED]

e ——
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A propos des projets et des solutions

Projet
Un projet est une collection de fichiers sources (.ino, .cpp, .c et / ou fichiers .h) compilés dans un programme que vous pouvez télécharger
dans une carte Arduino. Le projet contient également des propriétés, comme le type de carte ou le port nom / numéro.

Solution

Une solution consiste en un ou plusieurs projets. Vous pouvez utiliser des solutions pour agréger plusieurs projets en rapport les uns avec les
autres. Dans l'image ci-dessous, vous voyez un exemple de solution pour un systeme constitué de deux cartes : une pour réaliser un client et
I’autre pour un serveur, chacune avec son propre projet.

L’'image ci-dessous montre un exemple de solution. fl est |a solution, E et E sont les projets avec leur fichier source server.ino and client.ino.

Solution Explorer > B x
@Alo-2a@| FRAR|E
Search Solution Explorer (Ctrl+) P~

fa] Solution 'Metwork of inos' (2 projectlj—" 1
4 [ Client
b =3 External Dependencies
b =5l Header Files 2
B Resource Files
B9 Source Files
P #+ Clientino

4 [%] Server %
b =3 External Dependencies

b B Header Files
B Resource Files
=9 Source Files

P ++ Serverino
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